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Abstract

Myocarditis is an inflammation of the myocardium, but only ~10% of those affected show clinical manifestations of the disease. To study
the immune events of myocardial injuries, various mouse models of myocarditis have been widely used. This study involved experimental
autoimmune myocarditis (EAM) induced with cardiac myosin heavy chain (Myhc)-α 334-352 in A/J mice; the affected animals develop
lymphocytic myocarditis but with no apparent clinical signs. In this model, the utility of magnetic resonance microscopy (MRM) as a non-invasive
modality to determine the cardiac structural and functional changes in animals immunized with Myhc-α 334-352 is shown. EAM and healthy mice
were imaged using a 9.4 T (400 MHz) 89 mm vertical core bore scanner equipped with a 4 cm millipede radio-frequency imaging probe and
100 G/cm triple axis gradients. Cardiac images were acquired from anesthetized animals using a gradient-echo-based cine pulse sequence,
and the animals were monitored by respiration and pulse oximetry. The analysis revealed an increase in the thickness of the ventricular wall
in EAM mice, with a corresponding decrease in the interior diameter of ventricles, when compared with healthy mice. The data suggest that
morphological and functional changes in the inflamed hearts can be non-invasively monitored by MRM in live animals. In conclusion, MRM offers
an advantage of assessing the progression and regression of myocardial injuries in diseases caused by infectious agents, as well as response to
therapies.

Video Link

The video component of this article can be found at https://www.jove.com/video/51654/

Introduction

Heart failure is the leading cause of deaths, and myocarditis is one predominant cause of heart failure in young adolescents1. Most patients
affected with myocarditis remain asymptomatic and the disease is spontaneously resolved2. However, 10-20% of those affected can develop
chronic disease, leading to dilated cardiomyopathy (DCM)3. Various animal models have been developed to study the immune pathogenesis of
myocarditis. The disease can be induced in myocarditis-susceptible A/J and Balb/c mice by immunizing the animals with cardiac myosin heavy
chain (Myhc)-α or its immunodominant peptide fragments or by infecting with pathogens like coxsackievirus B3 4-9. This study involves Myhc-
α 334-352-induced myocarditis in A/J mice. Despite showing myocardial infiltrations, the myocarditis-affected animals appear clinically normal;
diagnosis is based on histological evaluation of hearts for inflammation7 and echocardiography10.

Magnetic resonance microscopy (MRM) is a commonly used method to obtain cardiovascular imaging with high resolution three-dimensional
planes, permitting assessment of functional details to the level of minute blood vessels (up to 10 μm diameter), but this level of resolving power
is not achievable with the routine magnetic resonance imaging (MRI) scanning procedure, in which, the resolution is generally obtained up to 1
mm11-14. MRM offers an advantage as it permits acquisition of high-resolution images and also to derive performance parameters in the early
time points of disease process14. Clinically, MRM imaging has been extensively applied to study the functional parameters of diseased heart,
lung or brain15-17. In this study, the use of an MRM technique as a non-invasive tool to ascertain cardiac abnormalities in A/J mice affected with
autoimmune myocarditis is shown. Specifically, the MRM imaging allows quantification of functional parameters such as left ventricular (LV) end-
diastolic volume and ejection fraction (EF) with reasonable accuracy18. The definitions of respective parameters are: LV end diastolic volume,
volume of blood in the left ventricle at the end of diastolic cycle, and ejection fraction, stroke volume/end-diastolic volume. The data analysis is
performed using the freely available Segment software developed for processing DICOM-compliant cardiovascular images acquired by magnetic
resonance scanners19. The data revealed an increase in thickness of the LV wall in the myocarditic animals, corresponding to a decrease in LV
end-diastolic volume, stroke volume and ejection fraction, as compared with these functional parameters in healthy mice.
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Protocol

ETHICS STATEMENT:

All animal procedures were conducted in accordance with the guidelines for the Care and Use of Laboratory Animals and approved by the
University of Nebraska-Lincoln, Lincoln, NE.

1. Induction of Experimental Autoimmune Myocarditis

1. Prepare the peptide solution by dissolving Myhc-α 334-352 in 1x phosphate-buffered saline to a final concentration of 2 mg/1.5 ml.
2. Prepare the pertussis toxin (PT) by adding 1 ml of sterile 1x PBS to a vial containing 50 μg of lyophilized PT to obtain a stock concentration of

50 ng/μl. Take 20 μl of the stock into a sterile 1.5 ml tube and add 980 μl of sterile 1x PBS to obtain a working concentration of 1 ng/μl.
3. Prepare complete Freund’s adjuvant (CFA) by adding 40 mg of Mycobacterium tuberculosis H37Rv (MTB) extract to 10 ml of CFA to obtain a

final concentration of 5 mg/ml.
4. Prepare the peptide-CFA emulsion. NOTE: For EAM induction, the peptide-CFA emulsion was administered in 150 μl containing 100 µg of

Myhc-α 334-352 per animal. For example, to immunize ten mice use 1.5 ml of peptide-CFA emulsion containing 1 mg of Myhc-α 334-352.
1. To prepare 1.5 ml of emulsion, aliquot 750 μl of Myhc-α 334-352 peptide solution in one 1.5 ml tube, and CFA supplemented with MTB

into another 1.5 ml tube. Using a 3 ml luer-lok syringe, draw the peptide solution first, followed by the CFA/MTB extract.
2. Attach the syringe to a 3-way stopcock and connect the other outlet of the stopcock to an empty 3 ml syringe. Adjust the patency of the

stopcock so the peptide-CFA mixture flows from one syringe to the other with reasonably good resistance.
3. Mix by pushing the contents from one syringe to the other repeatedly for ~1 min and then place the entire assembly on ice for ~3 min.

Repeat this procedure a minimum of 10x.
4. Determine the consistency of the emulsion by carefully placing a tiny droplet on still water in a 100 ml glass beaker. The droplet is not

expected to disperse in water. If it does, continue mixing until the desired consistency is achieved.
5. Transfer the contents of emulsion from 3 ml syringes into 1 ml luer-lok syringes by replacing one of the two 3-ml syringes attached to

the stopcock with the 1-ml syringe, and attach a 27 ½ G needle to the 1 ml syringe.

5. Inject 150 µl of the peptide-CFA emulsion in split doses subcutaneously in the two inguinal regions of six-to-eight-week-old female A/J mice
(~75 µl each).

6. Administer 100 μl of PT suspension (100 ng) intraperitoneally to each animal on day 0 and day 2 postimmunization.
7. Repeat the immunization procedure on day 7 by administering 150 µl of peptide-CFA emulsion in split doses subcutaneously into either side

of the sternum (~75 µl each). Prepare this emulsion fresh as above. Then, on day 21, subject the animals to MRM imaging, see step 3.

2. Animal Handling

1. Place each mouse in an anesthetic induction chamber containing 2% isoflurane-air mixture with a heating pad placed underneath to maintain
warmth, and transfer the animal to a specially designed animal holder (Figure 1).

2. Immobilize the animal in the prone position on the animal holder so its snout fits into the nose cone to maintain anesthesia (Figure 1). Secure
the head of the mouse with a bite-bar attached to the front teeth of the mouse.

3. Turn on the air blow heater with its outlet hose inserted in the scanner’s vertical bore to maintain the animal’s body temperature during the
experiment.

4. Maintain anesthesia at 0.5 to 2% isoflurane with a flow rate of 2 ml/min during the entire imaging session. Confirm anesthesia using the toe
pinch method, no movement expected.

5. Set up a pneumatic pillow sensor, mouse tail/ankle fiber optic pulse oximetry sensor, and rectal temperature probe to monitor respiration,
heart rate and body temperature, respectively (Figure 1). Note: Cardiac gating is performed through Pulse Oximetry, which allows
noninvasive monitoring of arterial blood oxygen saturation. The pulse oximetry sensor should be attached to the left ankle, and the foot
should be secured with a thread loop and taped to maintain the ankle in the sensor. MRM imaging is achieved by gating the respiration and
cardiac signals without the use of any contrast agents.

3. Image Acquisition

1. After preparing the animal (Figure 1), place the mouse in the center of the MRM scanner with the heart positioned in the center of the field of
view (FOV), where magnetic field homogeneity is maximum. NOTE: A wide-bore (89 mm) 9.4 T vertical-bore magnet equipped with triple axis
gradients of 100 G/cm and a 4 cm radio-frequency (RF) imaging coil is to be used to obtain high-resolution three-dimensional (3D) images.
Note: Be sure to non-magnetic supplies when using an MRI scanner. 

2. Run the imaging interface and select “New Study” from the “Study Options” menu. Type “mtune” at the command bar and run it to pull up
the “Tune GUI”. Then select “Start Probe Tune” and click on “Autoscale” button. The Tune GUI will change to show the RFsignal. Use the
remote tune/match knobs at the end of the coil to tune the RF coil to the proton resonance frequency (400 MHz). On the “Start” tab go to the
“Prescan” page to run the frequency and power calibration by clicking on the related buttons. Hit the XYZ (quick) button on the ‘Shim” tab of
“Study’ tab to pull up the shimming page. Go to the shim page, select all of the iterations, and hit the shim button to perform auto shimming.

3. Select a scout sequence from the “Study” tab of the imaging interface to localize the mouse heart. On the “Acquire” tab change the FOV to 35
mm2 and keep the machine’s default settings. Click Start to run the sequence; adjust the position of the animal holder if the heart is not in the
center of FOV, retune the RF coil and obtain the scout images again.

4. Click the “GEMS” sequence button on the “Study” tab then enter the acquisition parameters on the corresponding “Acquire” tab to obtain two
orthogonal planes along the short axis and long axis of the heart20,21. NOTE: Typical acquisition parameters for a gradient-echo scan are:
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slice thickness, 1 mm; repetition time (TR), 200 msec; echo time (TE), 2.67 msec (minimum); flip angle, 25°; inplane matrix size, 128 x 128;
FOV, 22 mm2; number of acquisitions, 4; and an approximate acquisition time of 1 min and 30 sec.

5. On the “Adv” tab select the “CINE” sequence to collect the pulse oximetry-gated short-axis cine MR images in order to measure the LV
anatomic and functional parameters. Adjust the position and angle of the imaging slices based on the long axis view of the heart by mouse
hovering and dragging. Enter the following imaging parameters on the “Acquire” tab to obtain the gradient echo cine sequence: TR, 500
msec; TE, 5 msec; FOV, 22 mm2; acquisition matrix, 256 x 256; slice thickness, 1 mm; number of acquisitions, 8; number of frames, 6; and an
acquisition time of ~17 min. Click start to begin the acquisition.

6. Convert the acquired images to DICOM format using the “I/O” tab of the imaging software and transfer the corresponding files to the data
center for processing.

7. At the end of imaging procedure, allow the mice to recover from anesthesia within the filter-top cages. Do not leave the mice unattended until
they regain sufficient consciousness to maintain sternal recumbency and keep them for further studies as needed.

4. Data Analysis of Cardiac Magnetic Resonance Microscopy Imaging

1. Use Segment software to analyze the anatomic and functional parameters of the LV19. By loading the DICOM format cine images into the
software using the “Open Image File(s)” submenu of the “File” menu. On the GUI select ‘MRGE’ as the imaging technique, ‘Cine’ as the
image type and ‘short-axis mid-ventricular’ as the image view plane.

2. Specify the time frames to be used for end-diastole and end-systole through the “Set Current Timeframe to End Diastole” and “Set Current
Timeframe to End Systole” submenus of the “Edit” menu respectively.

3. First click the “LV” command button and then the “ENDO” and “EPI” command buttons on the bottom-right panel to manually draw the left
ventricle endocardium and epicardium respectively. Remove the papillary muscles by hitting the corresponding command button in order to
increase the accuracy of the calculations.

4. Read the quantified LV parameters such as diastolic volume, systolic volume, stroke volume, and ejection fraction on the top-right panel.
Click the “Misc” command button and then the “Measurement Caliper” command button to measure the LV parameters such as wall
thickness, and ventricular diameter22.

5. Click the “Save Both Image Stacks and Segmentation” submenu of the “File” menu to save the images, including the segmentations, in ‘.mat’
format to reprocess the images as needed.

Representative Results

In this report, the utility of MRM technique as a non-invasive modality to determine the structural and functional changes in the hearts of
animals affected with EAM is shown. Myocarditis was induced in A/J mice by immunizing the animals with Myhc-α 334-352 in CFA7, and the
animals were subjected to MRM experiments on day 21 post-immunization. The MRM imaging was performed on live animals under isoflurane
anesthesia at 9.4 T (400 MHz for protons) using an 89 mm vertical-bore magnet equipped with triple axis gradients (maximum strength 100
G/cm). A scout image was acquired to locate and position the mouse heart in the center of the FOV, followed by axial images to obtain the
long-axis 4-chamber view. The angle at which the heart was imaged for the 2-chamber view is shown in Figure 2A. Cardiac images were
acquired using a 4 cm millipede RF imaging probe with a gradient-echo-based cine pulse sequence. Cardiac function measurements (imaging:
LV wall thickness; output: LV end-diastolic volume and ejection fraction) were then analyzed using Segment software. Structural defects in the
hearts of EAM-affected mice were evidenced by increase in LV thickness by approximately 1.5-fold (p = 0.018) (Figure 2B and Table 1), with
corresponding decrease in LV end-diastolic volume [18.0 ± 4.2 µl vs. 37.5 ± 3.5 µl, Figure 2C(i); p = 0.002] and ejection fraction [49.4 ± 2.3% vs.
71.5 ± 6.0%, p = 0.00066; Figure 2C(ii)] as compared to healthy mice. As expected, histological evaluation of hearts from myocarditic, but not
healthy, mice showed multifocal lymphocyte infiltrates, as we have demonstrated previously7; Figure 2D). The data suggest that morphological
and functional changes in inflamed hearts can be non-invasively monitored by MRM in live animals.

 

Figure 1. Animal preparation and positioning of probes for acquisition of MRM images from the mouse heart. To acquire images from
the heart, the anesthetized mouse is placed in the animal holder specially designed for MRM imaging and connected to the air blow heater to
maintain the body temperature. Under continuous anesthesia, the animal is immobilized in the prone position. A pneumatic pillow, fiber optic
oximetry sensor and temperature sensor are set up to monitor respiration, pulse and body temperature, respectively, until MRM acquisition of
cardiac images is complete. Please click here to view a larger version of this figure.
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Figure 2. MRM imaging of mice affected with autoimmune myocarditis reveals cardiac abnormalities. Myocarditis was induced in A/J
mice by immunizing the animals with Myhc-α 334-352 in CFA. The animals were subjected to MRM imaging on day 21 postimmunization to
evaluate cardiac abnormalities. (A) Position of MRM slicing. The angle at which the heart was sliced for image acquisition is shown. (B) MRM
imaging. Short-axis slices of heart were captured using echo-based cine pulse sequence in eight time frames with a TR of 500 msec (TE, 5
msec; flip angle, 20°; number of acquisitions, 4; acquisition matrix, 256 x 256) [arrows: LV wall thickness]. (C) Cardiac output. Cardiac output
was measured based on (i) LV end-diastolic volume and (ii) ejection fraction in healthy and myocarditic mice using quantitative medical image
analysis with Segment software. Mean SEM values for a group of mice are shown (n = 2 to 5 per group). (D) Histology. Hearts from the above
treatment groups were evaluated for inflammation by hematoxylin and eosin staining. Circles: multifocal lymphocytic infiltrations. Please click
here to view a larger version of this figure.

Animals Healthy (n = 3) EAM (n = 5)

Mouse 1 1.03 1.48

Mouse 2 1.3 1.59

Mouse 3 0.94 1.44

Mouse 4 2.11

Mouse 5 1.92

Mean ± SEM 1.09 ± 0.1 1.71 ± 0.1

Table 1. Comparison of left ventricular (LV) wall thickness between healthy and experimental autoimmune myocarditis (EAM) mice.
Three healthy and five EAM-induced mice were subjected to magnetic resonance microscopy (MRM) imaging on day 21 postimmunization. After
acquiring the cardiac images by MRM, the thickness of LV wall was measured using Segment software as described in the protocol. The values
displayed in the table represent LV wall thickness in mm.

Discussion

This study describes the MRM procedure and its utility as a non-invasive tool to ascertain cardiac abnormalities in mice affected with
autoimmune myocarditis. Since the histologic features of EAM resemble postinfectious myocarditis of humans, mouse models are commonly
employed to delineate the immune mechanisms of myocardial injuries23-25. However, the animals affected with myocarditis appear clinically
normal, and the diagnosis is made based on histology at the termination of experiments7. The animals are usually sacrificed on day 21
postimmunization. Assessing the disease process in this way at single time points limits use of these models, especially in pharmaceutical
research, where monitoring of disease progression in response to treatments is a critical requirement.

To ascertain cardiac abnormalities in living animals, use of non-invasive modalities like MRM is helpful. The MRM technique that described
here offers an advantage of obtaining the structural and functional characteristics of hearts without the need to use contrast agents. However,
this technique requires acquisition of high resolution 3D anatomical images in strong magnetic fields. Nonetheless, once the images are
acquired, functional parameters such as LV end-diastolic volumes and ejection fractions can be analyzed later using commercially available
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software, without the need to further assemble the MRM apparatus. As shown in Figure 2, MRM examination of animals immunized with Myhc-α
334-352 revealed LV wall thickness to be greater than in healthy mice (Figure 2B), with a corresponding decrease in functional outputs (LV end-
diastolic volumes and ejection fractions; Figure 2C). As expected, hearts from immunized, but not healthy, animals had inflammatory infiltrates
(Figure 2D). Thus, findings from the MRM technique and histology corroborate each other.

Nonetheless, to obtain reproducible results by MRM, the following three factors need to be addressed. (a) Animals should be placed in the MRM
scanner so hearts are positioned in the center of the magnet to expose them to the magnetic field with maximum homogeneity. (b) Motion artifact
is a concern in live animal experiments. To diminish image blurring due to respiration and cardiac movements, pulse oximetry and respirometry
were used to gate MRM acquisition—that is, to acquire discrete image signals at specific time points within the respiratory and cardiac cycles—
which required the use of an animal monitoring system. (c) Acquisition of high-resolution 3D cardiac images is a critical requirement to enable
detailed analysis of cardiac abnormalities. To obtain images in all three dimensions, and to increase signal-to-noise ratio, it is important to design
more sensitive imaging coils specific to MRM that permit accurate and complete capturing of images in strong magnetic fields in a short-axis
orientation within the animal scanners.

In conclusion, development of an MRM technique to evaluate cardiac abnormalities in live animals is challenging. This is especially true for mice,
because of their smaller heart sizes (~1/2,000 the mass of a human heart) and higher heart rates (~600 beats per min) compared to humans26.
Nonetheless, once developed and validated, the MRM technique can be used to compare the anatomical and functional changes of hearts
between healthy and sick animals. Thus, the MRM technique could serve as a valuable, non-invasive tool to assess the longitudinal progression
of inflammatory cardiac pathologies related to both the acute and chronic nature of the disease process, and to monitor responses to therapies in
living animals.
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